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1. INTRODUCTION

Grants and cooperative agreements are non-procurement used for awarding research and
development, to transfer a thing of value to carry out a public purpose of support or
stimulation authorized by law. A subject relevant to an interest of the Department of
Defense grants are typically awarded to universities or non-profit organizations and
involve no fee or profit. Grants are not issued on a SF 26 or DD 1155. Rather, they are
created in word processing programs using special “forms” and formats that roughly
correspond to regular contracting documents, for example, the DD 2566 corresponds to a
DD Form 350.

PD? is designed for contracting using procurement instruments, not grants. PD? provides
reporting, forms, etc. only for procurement objects. That said, grant shops are still DoD
procurement agents and must conform to the same constraints and processes as other
contracting offices using PD>.

1.1 Problem

Grants are awarded in PD? on a DD1155 Simplified Purchase and SF 26 Service Contract
form. Current (paper) business practices allow the site to:

1. Create word processing documents in the correct formats.

2. Save grant and regular contracting information in an organized, combined file format
3. Produce adequate reports and data extracts

4. Avoid double entry into procurement systems and grant writing systems.

This is normally accomplished by creating all awards in hard copy. Grants are written by
filling in and printing MS-Word templates with the information provided by the
engineering department. Procurement forms may be populated outside of PD2 All

documents are run through a scanner and archived electronically. Awards are sent in
hard copy to recipients/vendors and DFAS. No interfaces are used.
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2. GRANT WRITING WITH PD?

PD? can support grant writing by using SF 26 document icons as the object to which the
MS-Word files are attached in the form of PD? Attachments. All non-grant contracting
is as per standard PD? functionality. This allows one database to contain all awards. PD?
reporting, interfacing, etc. for grants is done by using standard reporting features,
transmitting, etc. on the SF 26 shell.

Key elements to creating grants in PD?:

MS-Word grant templates can be imported as Attachment templates, in the
Attachment Task of System Administration.

Enter minimum required data in the SF 26 in PD? so that the grant can be saved,
released, transmitted and reported as any other document in PD?.

The SF 26 is primarily a placeholder or “tracking” document for certain key data
items and does not replace the MS-Word files for a grant. Grants are still issued as
Microsoft Word documents.

Repetitive data entry can be avoided by using smart attachment templates.

2.1 Creating the SF26

a)

b)

Choose an appropriate cabinet and folder inside PD? for the grant and create a stand-
alone SF 26.

Change the default number in the Number field in the Create New SF 26 Award
window to the grant number.

Note: Grants use the same numbering convention as other awards, except that instead

of a C or D in the ninth position of the contract number, a “1” is entered for
grants and “2” is entered for cooperative agreements.

Enter the Grant Proposal Number in the Description field (ie, 39124-EV).

Enter the minimum required data in the ltems 1-10, ltems 11-15, Items 16-20 and
Clauses tab to save, approve and release the SF 26.

General Notes:

1. The Issuing Office should be the Granting Office, with short code, DODAAC,
etc. as per any other Issuing Office organization address.

2. The vendor is the grant recipient, e.g. MIT. The recipient should be entered into
Vendor Maintenance as per any other contractor with TIN, DUNS, CAGE, etc.

Line Item Notes:

1. The award should contain one line item. Enter “GRANT” or “Grant Line Item”
in the Description field. Enter the research title in the Extended Description
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field. Le.,
Heterogeneous Soils.”

Select FFP as the CLIN Contract Type.
Enter “1” as the Quantity of the grant.
Enter the grant amount in the Price field.

Select Lot or Job from the Unit of Issue drop-down list box.

A o

funding strip, ACRN and obligation amount in the Funding tab.

“Conditional Analysis of Unsaturated Flow in Randomly

Select the actual grant performance period in the Period of Performance field.

Click on the Funding tab. Click the [Add] button and enter the appropriate

Line Item Detail
Detail r Description T Pricing T Funding T Shipping T Payment T Local Info ]
Lire i Cortract (n]es Hanid Glahal Cho
ine tem anitr & En |
g Murnber PEID1 TvpeIFFP |:| Type INIA |:I Carry TestInfo
CLIM
:ll Delivery Date | {l | = -1y Type| ® Priced € Info Oniy| Copy
~ Description IGRANT —CLIN
il Extended ezearch into the nature of semiconducting electronic elements for small scale Add |
— Description joommunication arrays |
Insert
—SubCLIN —
Guantit: Unit Price Line ftem Cost Add
ttem Calculation | 1.00 | 1,539,000.00) | 1,539,000.00 —

Period of Start Date End Drate Period _ Opt# Cost Constraint
Performance F4-.&.ug-1999 FS-Aug-mDD ¢ Baze (. Option :E
Test Type
Unit of lssueLot | =] [re Test |=| FExhibt [ Include Sublines
Stepladder
Pricing I_

Insert

Delete

A=zociate

Cancel

A

g) Compile generic versions of grant documents in Microsoft Word.

h) Identify any data items on each grant document that should pull-through from the SF

26 to the Attachment.

Note:

Examples are proposal number, grant number, grant amount, etc

i) Select Utilities>System Administration. Click the Attachments Task.

j) Inthe Template Type window, highlight Grant/Cooperative Agreement. Click the
[Update] button.

k) Click the Templates tab.
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D

System Administration M= R

Tasks Modules | Templates | Document Types I Ata Fill-Ins:

é Template Type: IVI]isplay

3 o+ pctive " Dejeted " Both ‘
Analysis GrantiCooperative Agreement = E =
Templates File Created System Defined Fill-Inz
Classification
spproval ] |2:SEB Aszizt, Bweard Action SEtlst [x | Il Add |
-
E Financial Accounting Data Sheet [x | |l felete |
| = |
Aftachment Grant Award X | - Restore
| |:l Import |
Grant Avvard Attachment 1 [ (| Il =
| = Edit |
Test |
Cancel
et |

In the Templates tab, customize an existing template or add a new template for the
first Microsoft Word grant document

Note: Example: Grant Check Sheet

m) To add a new Template, click the [Add] button. Enter a unique title in the

p)

Templates field and select a classification from the Classification drop down list
box. A unique template name must be entered in the Templates field.

To add a new template, highlight the new Template Name and Classification on the
Templates tab, and click the [Edit] button. A blank Microsoft Word document
launches. Click Insert->File and search for the grant template saved as a Microsoft
Word that is saved a network directory. Click the [Open] button to insert the file.

Scroll through the text of the Microsoft word file, and confirm that the text required
for a new grant is provided.

Move the cursor to each location where a data from the SF 26 should pull through to
the Microsoft Word file and insert a bookmark by selecting Insert=>Bookmark.
Creation of the bookmark will allow information to be inserted automatically into the
attachment document when the Attachment is created in PD?.

Note: Please review the Appendix regarding which fields should be replaced with

bookmarks and more information about working with bookmarks in Microsoft
Word.
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@ File Edit Wiew | Insert Format Tools Table ‘Window Help

DS A gesk A
= =|@-2-A-

Page Mumbers...
FMY RESEARCH OFFICE

o 100% -

| =5

Marmal T B I U <
Date and Time...

AutoText

-

Eield... UTH MIAMI BOULEVARD
Symbl... P. 0. BOX 12211
#3 Comment 'RIANGLE PARK, NC 27709-2211
E°°tt_ﬂ°te"' RESEARCH GRANT
Sl DNSTRATION PARTNERSHIP (FDP)
Cross-reference. ..
1 AROPROI Index and Tables. ..
Picture 3
2. GEANT I & Text Box
File. ..
3. RECIPIEN  Ohject... RESS: ]

Books et
% Hyperlink...  ChrlH I

T
4 PRINCIPAL DNVESTIGATOR(S): Dr. 300300

5 STATEMENT WOREK; The researchto be accomplished 15 identified in the recipient's
proposal identified below which is incorporated by reference in this grant. The estimated cost of
the research 15 set forth in the budget and included as Exhibit &

I:]EIEIIEI{I I
[Page 1 Sect 15 [ae2s Lnie col 17 | [REC|[TRE B4 ovR | [REm [TIEEK

q) Replace any other text to be entered by the user with bookmarks.
r) Save and close Microsoft Word.

s) On the Document Types tab, select SF 26 from the Available Document Types and
associate it with this template.

t) On the Auto fill-ins tab, click the [Get List] button. A list of the bookmark names
that were created in the Microsoft Word file display.

u) Highlight the first bookmark name. The [Value] and [SQL] buttons are enabled.
Click the [Value] button to view a list of pre-defined values for the SF 26 document.
If the appropriate data item for that bookmark displays in the Choose Data Value,
highlight that row and click [OK].

Note: Document Name is the PD? description field, which should contain the proposal
number.
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v) If the required data item does not display in the Choose Data Value window, the
bookmark requires an SQL statement to the data from the SF 26 document into the
Microsoft Word file. If the System Administrator is not familiar with SQL, it may be
advisable to eliminate that bookmark and have users enter the data directly into the
Microsoft Word file when the Attachment is created in PD?.

w) To create an SQL statement to automatically pull forward that data item from the SF
26 into the Microsoft Word file, highlight the bookmark name and click the [SQL]
button. The Bookmark SQL window opens. In the SQL Description field enter in
a name for the SQL statement. In the SQL Statement field enter a query for that
data in the database. Include the phrase “proc_object.obj id = ?”” in the WHERE
statement to pull data from the attachment source document.

Note: Sample SQL statements are provided in the Appendix.
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x) Click the [Syntax] and [Test SQL] buttons to verify that the SQL statements pull the
appropriate information from the SF 26 in PD? to the bookmark position on the
Microsoft Word file.

y) Complete values or SQL for all bookmarks in the Attachment template.

z) Return to the Templates Tab and click the [Test] button to verify that the Attachment
template and bookmarks work correctly.

aa) Repeat steps a to z for each additional standard grant form and close the System
Administration window.

bb) Create all the Attachments needed to generate the grant in MS-Word format,
highlighting the SF 26 each time. Modify each Attachment as necessary and save in
PD>.

cc) C-G-G-G-A-R: Certify the funds on the SF 26, Generate CLINS, Generate Section J,
Generate Document, Approve and Release. Release will queue the information in the
SF 26 for transmission via SPS interfaces, e.g. CAPS to the DFAS office listed in the
SF 26.

dd) Print, email or otherwise transmit the appropriate grant file. This may involve
sending the recipient email or hard copies of the grant attachments only or the site
may choose to send Attachments and the SF 26.

ee) To modify the grant, create a modification to the SF 26 and adjust the Attachments
as necessary.

Grant Writing

7 February 27, 2001

AMS Proprietary - Not for Disclosure Outside the Government



2.2 Conclusion

PD? can effectively produce grants and grant documents.

The process described above will allow the user to create grant Microsoft Word files
quickly and easily in PD? It does require a significant amount of up-front work for the
System Administrator, and may also require extensive SQL writing, depending on how
sophisticated the attachment templates are designed to work. It is complicated (over 20
steps) the first time you set up a template, but once it is entered, the attachment templates
can be used over and over. This has the added benefit of standardizing the grant
templates for all contract specialists in the PD? database.

To put it in perspective, grant writers are currently manually creating all the documents in
Microsoft Word. In PD?, grant writing involves one extra step, filling out a shell SF 26.
Otherwise, the process is functionally the same and may even be streamlined by the
automatic data entry of smart attachments. Smart attachments are not required for users
willing to re-enter data into each Microsoft Word document.

Finally, Attachment templates do not have to be used. Users may simply create
Microsoft Word files outside of PD? and use the Document Import feature to load the
document into the database. Importing documents this way will not allow you to pull
data from the base SF 26 document, however, it will allow you to store the file inside of
the PD? database. This approach is not recommended.
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3. Appendix A

3.1.1 Working with Attachments, SOL and Smart Attachments

The process outlined in the main document describes how to generate smart attachments.
Insert a Microsoft Word bookmark into an Attachment template, get the bookmark list in
the Auto Fill-ins Tab and associate values or SQL statements to each bookmark.

Points to note:

Attachment templates are Microsoft Word files and can be adjusted as per any Word
file. They are functionally similar to local clauses.

The SQL statements listed at the end of this appendix assume that data was entered
as described above, in other words, that the proposal number was put into the
document Description field, the research title input into the CLIN Extended
Description, etc.

SQL statements are complicated and can return unexpected data if written
incorrectly.

SQL scripts in general are not supported by AMS and are offered with no warranty —
SQL instruction is available from Sybase

It is possible to corrupt the database with SQL, for example, running a delete
statement in SQL Advantage. It is IMPORTANT to be EXTREMELY careful when
writing SQL queries involving any commands other than SELECT and usually
should not be done without the express instruction of the OPDEV team.

If the database structure changes significantly after a SQL statement has been
created, the SQL statement may not work properly. This may occur during major
version upgrades.

Working with bookmarks can be complicated and may return unexpected data, as per
the underlying SQL.

Common Pitfalls:

a)

b)

It can be hard to see bookmarks in Microsoft Word. Make sure that bookmarks are
visible by selecting the Tools — Options from the menu bar and check the View
Bookmarks box in the Options workbook in Microsoft Word.

Exiting the Auto Fill-Ins tab without assigning all bookmarks values or SQL
statements will cause an error message to display. Please assign the correct value to
all bookmarks before exiting the Auto Fill-Ins tab and saving the template.

Adding, deleting or editing bookmarks after the initial bookmark list has been
generated and assigned values can cause strange system behavior in PD?. It is highly
recommended that the template be re-created rather than try to add, edit or remove
bookmarks and/or reassign values to bookmarks once the initial template has been
saved. You are able to modify formatting and text in Microsoft Word without
difficulty, however, modifying bookmarks may cause errors
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d)

g)

h)

If multiple documents are associated to a given template in the Document Types tab
of the SA Attachments window, Auto Fill-In values will only be available for fields
common to all associated document types. This means, for example, that if you
select an SF 26 award and an SF 1449 commercial solicitation, the only pre-defined
values available will be Document Name, Document Number and Issued By, since
a solicitation does not have a Contract Amount or Award Effective Date.
Associate as few document types as possible to a given template.

If a template has not been associated to a given document type, an attachment cannot
be created using that type as the source document. In other words, if the document
type SF 26 is not assigned to your template, if you highlight a SF 26 and try to create
an Attachment using that template, the system will produce an error message.

The Modules tab controls which document types are available to be associated with
that template. Each module corresponds to a specific set of documents. Use the
Contract Placement module to get the SF 26.

It is possible to have two or more versions of the same attachment information if the
user is not careful how files are saved. When an Attachment is created in PD?, an
Microsoft Word file is generated and populated with the template information. The
user can then edit this in Microsoft Word and when finished, close and return to PD?2.
Changes are saved to the document in PD? If the user instead saves a copy of this
file on the local hard disk and then subsequently modifies the hard disk copy and not
the PD? copy, those changes will not appear in the PD? database version of the file.

Information regarding what fields are in what table is contained in the PD?* Data
Model listing from the Help menu. It is not immediately obvious exactly where and
how each table links to another. A good way to establish a link is to find the table
that contains the field you want and then find a table or series of tables that contain
one field from proc_object and one field from the next table. For example, org_id is
not in proc_object but proc object and award share an obj id field. Award and
address share an org id field. To get from proc object to address, use the award
table. Look for common keys such as org id or obj id to match tables, but be aware
that the org_id in one table may match to issu_org_id in another table or obj id of a
Mod may be quite different from the obj_id of an award

The SQL script doesn’t return the right data and it “looks” right. Open up wisql.exe
(SQL Advantage) and try running the SQL script on a particular object in the
database, for example, record 786 in proc object. It is often easier to modify and
troubleshoot SQL in wisql than in the Attachment window. Also, to add a line in
the attachment window, press <Ctrl> and <Enter>, not <Enter>.

3.1.2 Example SQL Scripts

Research Title (Extended CLIN Description)

select clin_ext desc

from proc_object,line_item

where proc_object.obj id = ?

and proc_object.obj id = line_item.obj id
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Start Period of Performance
select perf start dt

from proc_object,line_item
where proc_object.obj id = ?

and proc_object.obj id = line_item.obj id

Vendor Name

select org_nm

from proc_object,award,organization
where proc_object.obj id = ?

and proc_object.obj id = award.obj id

and award.vend_org id = organization.org_id

Vendor Street Address

select Str_addr nm

from proc_object,award,address
where proc_object.obj id = ?

and proc_object.obj id = award.obj id

and award.vend_org id = address.org _id {assumes only one address per vendor)

Vendor Zip Code

select zip_cd

from proc_object,award,address
where proc_object.obj id = ?

and proc_object.obj id = award.obj id
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and award.vend _org id = address.org id {assumes only one address per vendor}

Funding Strip

select fund_strip _cd

from proc_object,clin_fund, fund source ref
where proc_object.obj id = ?

and proc_object.obj id = clin_fund.obj id

and clin_fund.fund_id = fund _source_ref.fund id
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4. Appendix B

4.1.1 Going Paperless

Most users will continue to print and mail/fax grants to recipients after starting to use
PD?  Grant attachments cannot be sent via EDI, as this only applies to selected
procurement objects. Documents can be sent electronically through other means, most
notably as email attachments or posted to the web.

To email a grant, open the PD? Attachment in Microsoft Word, save a copy as a new file
name and use the standard email program to email the file as an attached file in the email.

To post a grant to the web, use a third-party program like Adobe Writer or Microsoft
Word to create a web compatible file. Using Adobe, save the file as a *.pdf Acrobat
reader file. Using Microsoft Word, simply save as an HTML file. Once created, the web
master can post these files.
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5. Appendix C

5.1.1 Clauses

Since grants are just Microsoft Word files, there is no Clause tab in the actual grant
document. If the SF 26 shell is not sent to recipients, the grantee will not see any clauses
brought into the SF 26 document. To simplify user workload, clauses can be added
directly into the Attachment templates when the templates are first generated and then
the Microsoft Word file. If the SF 26 will be issued, simply add clauses to the SF 26
object using PD? standard procedures.

Note that clause updates will not update Attachment templates. The System
Administrator will have to adjust the templates manually as the relevant clauses change if
the SF 26 is not issued. Fortunately, clauses for grants are relatively few and
straightforward. Also, sites using Microsoft Word for grants must currently maintain
Microsoft Word files containing clauses, and switching to PD? will not add to this
workload, they will simply have to keep maintaining grant clauses in Microsoft Word.
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